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Internet radio station.
Radiosolution is a SHOUTcast hosting provider located in Quebec Canada. We also offer Icecast, Wowza
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internet radio station can be intimidating, many people want to start one, but have no idea where to
start. Radiosolution will be there for you every step of the way. Everyday people are searching the
internet for free SHOUTcast servers. With Radiosolution SHOUTcast hosting we will allow you to try our
services for FREE. By trying our services, you can be confident that you have chosen the best radio
server hosting provider. You have nothing to loose because we offer a 30 day satisfaction guarantee.
What are you waiting for? Contact us now! Radiosolution offers everything you need to start internet
radio station. You will not need to go anywhere else. We can create your website, market your station
and help you submit your station to online directories. We also feature the voice of Derek Bullard aka
Dibblebee He can create affordable commercials, DJ intros, sweepers, jingles, ids and so much more.
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Contact us today
info@radiosolution.info

AdBlock Radio
Open Source filter application that uses advanced data algorithms to remove adverting or speech from a
live audio stream.
The Kdenlive Quick Start Guide
Open Source non linear video editing software application.
Shotcut Quick Start Guide
Open Source non linear video editing software application.
Imaginary Teleprompter
Open Source and easy to use Teleprompter that can be run on several operating systems.
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Edited by
David Childers
It is time to take In Stream advertising serious, as there are many industry / technology changes coming
into play.
Adblock Radio is an open source project that improves your radio experience and allows the listener to
be their own radio content curator.
This application is the first working ad filter for online streaming radio that creates a more genuine
relationship between media and their audience
The application allows listeners to skip in-stream advertising and chit-chat on your favorite radios.
Alexandre Storelli is currently developing this project in Lyon, France.
In 2015, Mr. Storelli completed his physics Ph.D. doctorate studies which involved data analysis and
signal processing skills. As a radio listener, he decided to put this experience to good use by bringing
about significant change in the radio sector. His goal is to encourage media to rely less on ads, and more
on direct subscriptions.
The software uses an advertising detection algorithm that combines machine learning and acoustic
fingerprinting (Shazam-like) techniques. The algorithm can distinguish between music, talk, and
advertising. The filtering software recognizes most new ads by itself and periodically receives updates
in the background.
The software application will be available soon on standalone multimedia players such as Adblock Radio
Buffer.
Preparations are being made for the creation of software modules for the following stand-alone devices:
- Smart speakers.

- Vehicle radio systems.

- DAB and Wifi radios.

- Mobile applications.

http://www.adblockradio.com/en

Hey You! Yes, You!
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http://www.ielectrify.com/work-with-me/
I am a professional writer with 15+ years of experience
creating high-converting copy, for a variety of radio,
broadcasting and marketing applications.
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The Kdenlive Quick Start Guide
This documentation was converted from the KDE UserBase
Kdenlive/Manual/QuickStart page.

The Kdenlive Quick Start Guide
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Abstract

The Kdenlive Quick Start Guide

Chapter 1

Quick Start
1.1

Creating a new project

Kdenlive directory structure
The first step is creating a new (empty) folder for our new project. I will call it quickstart-tutor
ial/ in this tutorial. Then get some sample video clips, or download them from here:kdenlivetutorial-videos-2011-avi.tar.bz2 (7 MB)1 , and extract them to e.g. a quickstart-tutorial/Video
s/ subfolder inside the project folder.
The image on the left shows the suggested directory structure: Each project has its own directory,
with video files in the Videos subdirectory, audio files in the Audio directory, etc. (read more)
(The tutorial from now on assumes that you use the sample videos provided, but it works with
any.)
1

If you prefer Theora (which you probably don’t since Ogg Video usually causes problems), you can alternatively
download kdenlive-tutorial-videos-2011-ogv.tar.bz2.
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New Project dialog
Open Kdenlive and create a new project (File → New).
Choose the previously created project folder (quickstart-tutorial/ ) and select an appropriate
project profile. The video files provided above are 720p, 23.98 fps.2 If you are using your own
files and don’t know which one to use, Kdenlive will suggest an appropriate one when the first
clip is added 3 , so you can leave the field on whatever it is.
2 720 is the video height, p stands for progressive scan in contrast to interlaced video, and the fps number denotes the
number of full frames per second.
3 Provided Configure Kdenlive Settings under Misc is set to Check if first added clip matches project profile

6
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1.2

Adding clips

Project Tree: Adding video clips
Now that the project is ready, let’s start adding some clips (i.e. the ones you downloaded). This
works via the Project Tree widget; a click on the Add Clip icon directly opens the file dialog, a
click on the small arrow shows a list of additional clip types that can be added as well. Video
clips, audio clips, images, and other Kdenlive projects can be added via the default Add Clip
dialog.

Kdenlive 16.08 window with the tutorial files
After loading the clips, Kdenlive will look similar to this. On the top left there is the already
known project tree. Right of it are the monitors that show video; The clip monitor displays
7
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video from the original clips, the project monitor shows how the output video will look, with all
effects, transitions, etc. applied. The third, also very important, item is the timeline (below the
monitors): This is the place where the video clips will be edited. There are two different types
of tracks, Video and Audio. Video tracks can contain any kind of clip, audio tracks as well – but
when dropping a video file to the audio track, only the audio will be used.

Saving a Kdenlive project
Let’s save the work via File → Save. This saves our project, i.e. where we placed the clips on the
timeline, which effects we applied, and so on. It can not be played.4 The process of creating the
final video is called Rendering.

1.3

Timeline

See also Timeline section of the manual
Now comes the actual editing. Project clips are combined to the final result on the timeline. They
get there by drag and drop: Drag some Napoli (assuming you are using the files provided above,
as in the rest of this quick start tutorial; If not, please make sure your screen is waterproof, and
perhaps tomatoproof) from the project tree, and drop it onto the first track in the timeline.

First clips in the timeline
4 To be correct, it can be played using melt yourproject.kdenlive, but this is not the way you would want to present
your final video since it is (most likely) too slow. Additionally, it only works if melt is installed.
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Since some cutlery is needed as well, grab the spoon clip and drop it on the first track as well.
Then drag the Napoli to the beginning of the timeline (otherwise the rendered video would start
with some seconds of plain black), and the Spoon right after the Napoli, such that it looks like in
the image on the left. (Where I have zoomed in with Ctrl-Wheel.)

Timeline cursor
The result can already be previewed by pressing Space (or the Play button in the project monitor).
You will see the Napoli directly followed by a Spoon. If the timeline cursor is not at the beginning,
the project monitor will start playing somewhere in the middle; you can move it by dragging it
either on the timeline ruler or in the project monitor. If you prefer keyboard shortcuts, Ctrl-Home
does the same for the monitor that is activated. (Select the Project Monitor if it is not selected yet
before using the shortcut.)

Resize marker
Since after eating comes playing, there is a Billiards clip. Add it to the timeline as well. For
the first 1.5 seconds nothing happens in the clip, so it should perhaps be cut to avoid the video
becoming boring. An easy way5 for this is to move the timeline cursor to the desired position
(i.e. the position where you want to cut the video), then drag the left border of the clip when the
resize marker appears. It will snap in at the timeline cursor when you move close enough.

Overlapping clips
To add a transition between eating (the Spoon) and playing billiards, the two clips need to overlap.
To be precise: the second clip should be above or below the first one and end some frames after
the second one begins. Zooming in until the ticks for single frames appear helps here; it also
makes it easy to always have the same transition duration, five frames in this case.
You can zoom in by either using the zoom slider at the bottom of the Kdenlive window, or with
Ctrl-Mousewheel. Kdenlive will zoom to the timeline cursor, so first set it to the position which
you want to see enlarged, then zoom in.
5

Writing it this way suggests that there are several ways of cutting a clip. This is in fact true.
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Transition marker
Now that the clips overlap, the transition can be added. This is done either by right-clicking on
the upper clip and choosing Add Transition or, easier, by clicking the green triangle that appears
when you hover the mouse over the lower right corner of the Spoon clip. The latter, by default,
adds a dissolve transition, which is in this case the best idea anyway since the Spoon is not
required for playing.
The dissolve transitions fades the first clip into the second one. See also Transition section of the
manual.

Let’s now add the last clip, the Piano, and again apply a dissolve transition. When adding it
on the first track of the timeline, you need to click on the new clip’s lower left edge to add the
transition to the previous clip.

10
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1.3.1

Effects

Effect List
The Piano can be colourized by adding an effect to it. Select the piano clip, then double-click the
RGB Adjustment effect in the Effect List. If it is not visible, you can get it via View → Effect
List.

Once the effect has been added, its name will be added to the timeline clip. It will also be shown
in the Effect Stack widget.

11
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Effect Stack with RGB adjustment
To get a warm yellow-orange tone on the image, fitting the comfortable evening, blue needs to
be reduced and red and green improved.
The values in the effect stack widget can be changed by using the slider (middle mouse button
resets it to the default value), or by entering a value directly by double-clicking the number to
the right of the slider.
Effects can also be added with the Add new effect icon (framed in the image on the left) in the
Effect Stack; It always refers to the timeline clip that is currently selected. By unchecking the
checkbox they are temporarily disabled (the settings remain though), this is e.g. useful for effects
that require a lot of computing power, so they can be disabled when editing and enabled again
for rendering.
For some effects, like the one used there, it is possible to add keyframes. The framed watch icon
indicates this. Keyframes are used for changing effect parameters over time. In our clip this
allows us to fade the piano’s colour from a warm evening colour to a cold night colour.

12
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Keyframes for effects
After clicking the keyframe icon (the clock icon framed in the previous image), the Effect Stack
widget will re-arrange. By default there will be two keyframes, one at the beginning of the
timeline clip and one at the end. Move the timeline cursor to the end of the timeline clip, such
that the project monitor actually shows the new colours when changing the parameters of the
keyframe at the end.
Make sure the last keyframe is selected in the Effect Stack’s list. Then you are ready to flood the
piano with a deep blue.
Moving the timeline cursor to the beginning of the project and playing it (with Space, or the Play
button in the Project Monitor), the piano should now change the colour as desired.
Keyframing was the hardest part of this tutorial. If you managed to do it, you will master Kdenlive easily!
See also Effects section of the manual.

13
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1.3.2

Music

Audio fadeout
Since the clips do not provide any audio, let’s search for some nice piece of music, from your
local collection or on web pages like Jamendo. The audio clip should, after adding it, be dragged
to an audio track on the timeline.
The audio clip can be resized on the timeline the same way as video clips are. The cursor will
snap in at the end of the project automatically. To add a fade out effect at the end of the audio
clip (except if you found a file with exactly the right length) you can hover the top right (or left)
edge of the timeline clip and drag the green disc to the position where fading out should start.6
6

This green disc is a shorthand for adding the effect Fade → Fade out. Both ways lead to the same result.
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1.4

Rendering

Rendering dialog
A few minutes left, and the project is finished! Click the Render button (or go to Project →
Render, or press Ctrl-Enter) to get the dialog shown on the left. Select the desired output file for
our new video with all effects and transitions, choose MPEG4 (works nearly everywhere) and a
bitrate of 2000k (the higher the bitrate, the larger the output file and the better the quality – but
since the bitrate for the input clips was 2000k already, using a higher one would not improve
quality and is therefore unnecessary), and press the Render to File button.

15
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Rendering progress
After some seconds rendering will be finished, and your first Kdenlive project completed. Congratulations!

Rendering progress
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1.5

Complete manual

Further documentation for the current version of Kdenlive can be found in the full manual.

17
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Chapter 2

Credits and License
Documentation Copyright see the UserBase Kdenlive/Manual/QuickStart page history
This documentation is licensed under the terms of the GNU Free Documentation License.
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© Copyright 2017, K12 Handhelds, Inc. Licensed CC BY 4.0.

ShotCut (www.shotcut.org) is a free, open source tool that runs on Windows, Mac, and Linux. It
can be used as a media player or a video editing tool. Tutorials are available at
www.shotcut.org/tutorials/
Adding video clips, audio or images
You may begin my assembling all of your media items into a playlist. This will serve as a “bin” from
which you can create your timeline. To do this:





Open the Playlist panel by clicking Playlist
on the top menu. The Playlist panel will
appear on the left side.
Drag and drop media elements from their folder into the Playlist panel.
OR
Use Open File on the top menu to open a file in the player. Set the in and out points of the
clip in the player if you like and then use the plus button
panel to add it to the playlist.

at the bottom of the playlist

Alternatively, you can drag and drop media elements directly into your timeline.
Using the Timeline







Open the Timeline panel by clicking Timeline
on the top menu. The Timeline panel
will appear at the bottom of your screen.
Drag and drop a media element from a folder or from your Playlist to add it to the Timeline.
To create a new audio or video track, use the Timeline menu button
and Add Audio
Track or Add Video Track.
Use the other buttons to append, delete, cut, copy or paste clips. You can also right-click or
drag clips to move them.
In the event of multiple tracks with visuals, the top-most track is what will appear in the final
output.

Adding Transitions





To add a transition such as a fade, you must have two media clips immediately adjacent to
one other on the same track of the timeline.
Drag one media element to slightly overlap the other to add a transition.
The transition can be resized by dragging the handles.
Select the transition and click Properties in the top menu to display and edit its properties
(both video and audio).

© Copyright 2017, K12 Handhelds, Inc. Licensed CC BY 4.0.

Adding Captions or Title Screens
Text or captions can be added to a video by using a filter. (Other filters are available for things like
fading in or out audio or video, normalizing audio, stabilizing video, adjusting brightness or contrast,
cropping, etc.)




First select the clip or track you wish to apply the filter to.
Click Filters in the top menu.
Click + in the Filters panel.



Select the filter you wish to apply. (Note:



video filters.
shows all audio filters.)
Adjust settings as needed.

shows your favorite filters.

shows all

Notes: Fancier title screens are best added as graphics. Closed captions can be added with
YouTube.
Recording Narration



You can record directly into Shotcut by going to the File menu and selecting Open Other.
Under Devices, choose Direct Show and your microphone under Audio Devices. To begin
the recording, choose the WAV preset and Capture File.
 Record your audio, and click Stop Capture when done.
 The file you recorded will be in your main viewer and can be added to your Playlist or
Timeline.
Alternatively, you can record in Audacity, export to a WAV or MP3 file, and import into Shotcut.
Saving your Project



Make sure to save your project as you work by using the Save button in the top menu.
Saving the project will create an MLT XML (.mlt) file. This can be opened and edited in
Shotcut but cannot be viewed as a video by people who do not have the Shotcut program.

Exporting Your Final Video





Use the Export button on the top menu to render your video for viewing.
Complete all your edits first.
Then click Export.
Set the options you like and then click Export File. For video to be uploaded a web site,
H.264 Main Profile is a good option.
Note that rendering a final video can take some time, depending on the length and
complexity of your project.

Extras:





Panels, such as the Playlist or Filters, can be closed by clicking the X in the upper right corner.
If you’re not sure what a button does, mouse over it for a clue.
The various panels and screen areas in Shotcut can be resized or detached to optimize viewing
and use.
More help available at www.shotcut.org
© Copyright 2017, K12 Handhelds, Inc. Licensed CC BY 4.0.
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About Imaginary Teleprompter
Teleprompter by Imaginary Films, currently known as Teleprompter by Imaginary Sense, and from
next release till the end of time as Imaginary Teleprompter and sometimes simply referred to as
Teleprompter, is a professional, free software, easy to use Teleprompter, that can run on many
operating systems, including Linux, Mac OS, and Windows. We created it to promote the
democratization of media by enabling more people to produce quality contents, and to promote the
adoption of free software solutions by the media industries.

About Free Software
Free software, as defined by the Free Software Foundation implies we, the software developers, give
you, the user, the right to use, modify, and distribute the software at no cost, for any legal purpose,
as long as due credit is given to the developers. This is done under the General Public License
version 3.0, which requires modifications to be publicly disclosed, makes the software come with no
warranty, requires a copy of the license to be shared with the software and a copy of the source
code (the code that makes the program) to be shared along binaries (versions of the program that
computers run). See the GPL3 at https://www.gnu.gpl.org/licenses/gpl-3.0.en.html for details.

Versions of Imaginary Teleprompter
Online Version
The online version exists for user testing purposes and helps provide instant, online, access to high
quality teleprompter software in case of production emergencies.
A lot of efforts go into making sure the online version is as productive and feature rich as the
standalone version. This is not always possible because of browsers’ security limitations, which
should not be bypassed. Therefore we recommend using the standalone version whenever possible.

Standalone Version
These are copies of Imaginary Teleprompter you download and run from your computer. Most efforts
go into developing this version. It is the fastest and most feature rich version of Teleprompter.
Standalone is derived from the online version. Both standalone and online versions are free
software, under the GPL v3, and shall remain free forever. See About Free Software for details.

Mobile Versions
We have created early prototypes of Imaginary Teleprompter for mobile devices, specifically the
Android and iOS platforms. These are experimental versions, they’ve been stripped of GPL
derivative code, remain under our copyright, and haven’t been publicly released. See how we
manage copyright under the GPL for details.
Mobile versions are solely used by Imaginary Sense and it’s clients. They’re incomplete and are
currently only meant only to satisfy the needs of particular users.
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Specifications
System Requirements
Some of the following specifications are RAW estimates. Imaginary Teleprompter may
be able to run with lower resources where indicated with an asterisk.
•

CPU: We recommend having least @1.8 GHz and 4 virtual cores, like a dual core with hyper
threading, such as the Intel Core 2 Duo. Teleprompter could run well with lower end CPUs but
tests have not been rigorous so we can’t guarantee a good experience.

•

CPU (ARM): Performance is dependent on the kind of ARM and how the binary is compiled.
◦ 32 bit ARMHF architecture binaries are able to provide a smooth scroll at 720p resolution
on a Raspberry Pi 3.
◦ 32 bit ARM7L needs higher CPU frequencies because it uses software emulation for
floating point (decimal) calculations. Teleprompter animations are computed at the
subpixel level, resulting on a higher CPU consumption. Using these binaries on a
Raspberry Pi 3 requires a maximum resolution of 640 x 480 for a slightly jittery
animation.
◦ ARM64 binaries are possible but we don’t have the adequate hardware to make them or
test it.

•

RAM: 128 Mb free, recommended; 96 Mb free, minimum necessary to run.

•

Storage: 278 Mb required (128.60 Mb for Teleprompter, ~128 for dependencies, plus 32 Mb
contingency space)

•

Video Card: 1 to 2 screen outputs. 640 x 480 minimum resolution, no maximum resolution.
Minimum 16 bit color. Intel HD Graphics Series works good with a single screen. Dedicated
graphics are advised for 2 screens.

•

Internet: 56k modem or higher speed internet access required to use the math equation
editor and the spell check functionality.

•

Peripherals: Keyboard required, mouse is necessary to fully operate the software, but for all
basic features a keyboard is enough.

•

Additional peripherals: Teleprompter Interfaces that operate as a mouse wheel should be
compatible. No brand is officially supported as of this release. Please see Donate hardware
to us, to help us increase support.

Officially Supported Web Browsers
•

Desktop Browsers
◦ Google Chrome
◦ Mozilla Firefox
◦ Apple Safari
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•

Mobile Browsers
No mobile browsers are officially supported yet

Officially Supported Platforms
•

Windows
◦ Windows 7 and later (x86 and amd64 architectures)

•

Mac OS
◦ OS X 10.9 (amd64 architecture)

•

Linux
◦ Ubuntu 12.04 (i686 and amd64 architecture)
◦ Arch (Antergos and Manjaro) (i686 and amd64 architecture)
◦ Fedora 21 (i686 and amd64 architecture)
◦ AppImage (i686 and amd64 architecture)

Unofficially Supported Platforms
•

BSD
◦ FreeBSD (amd64 architecture)

Linux Dependencies
Imaginary Teleprompter uses the Electron Framework to work as standalone application under
Linux, Mac OS and Windows. The following the dependencies are Electron dependencies that must
be satisfied to run under Linux. You don’t need to install Electron as a dependency on your system
because it’s included with Imaginary Teleprompter’s package builds.
•

C-ares

•

libevent libvpx

•

nss

•

libappindicator-gtk2

•

ffmpeg

•

libxslt

•

re2

•

libappindicator-gtk

•

gtk3

•

libxss

•

snappy

•

libappindicator-sharp

•

http-parser

•

minizip

•

libnotify

Supported File Formats
Teleprompter exports slightly customized HTML files, we refer to these as Teleprompter HTML. These
files can be used from version 2.3.0 onward. Support for more formats shall be added in future
releases.

Teleprompter HTML
Teleprompter’s HTML files are unique in two aspects:
1. Fonts and images use relative units of measurement such as em and %.
2. They go straight to contents, containing no header or body tags as of Teleprompter version
2.3.1.
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Contribution Guidelines
Ways to Contribute
•

Promote the software

•

Request a feature

•

Report a bug or difficulty using the software

•

Maintain Imaginary Teleprompter on a Linux repository

•

Donate hardware to us

•

Become a translator

•

Add a feature or support a platform

Promote the Software
If you found Teleprompter scouting the web for a good free teleprompter software, you’ll probably
realize one thing: “It needs exposition”. Give us a big thank you by recommending it to your peers
and giving us a mention on your videos or at Twitter. You’ll make our day!

Request a Feature
While we have our ideas on what Imaginary Teleprompter should be, we want to hear from you. Your
need might be somebody else’s need, and your idea may be easier for us to develop than you
might think.
The best way to request a feature is through GitHub at:
https://github.com/ImaginarySense/Teleprompter-Core/issues
But you may just as well contact us through email at: support@imaginary.tech or at Facebook.

Report a Bug or Difficulty Using the Software
We take bugs and criticism to heart and so far we’ve fixed every single thing that’s been pointed
out to us (except for the layout of our website, that has design flaws but we’re not going to fix them
yet). If you have anything to say regarding Teleprompter, we’ll be happy to attend to your feedback.
The best way to report a bug is through GitHub at:
https://github.com/ImaginarySense/Teleprompter-Core/issues
But you may just as well contact us through email at support@imaginary.tech, or at Facebook:
https://www.facebook.com/imaginarytech/

Maintain Imaginary Teleprompter on a Linux repository
One of the best ways for Imaginary Teleprompter to be exposed to users are Linux repositories.
We’re a small, busy, team and cannot get behind all the distributions by ourselves. If you’re a Linux
enthusiast, like we are, please consider helping us get this software to the all the mayor distros.
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1. First, familiarize yourself with our building process at:
https://github.com/ImaginarySense/Teleprompter-Electron#installer-building-instructions
2. Then, if you think you can help to create and maintain the packages for the distribution of
your choice, write an email to Javier Cordero <javier@imaginary.tech> regarding your
intentions.

Donate Hardware to Us
We want Imaginary Teleprompter to work with as many hardware interfaces used in the industry as
possible. We also want it to work on as many platforms as possible. You could mail us any spare
hardware to:
Javier Cordero Pérez (Teleprompter)
Urb. El Prado
75B Calle Israel Roldán Blas
Aguadilla, PR 00603-5852
It would be best if you communicate with us by e-mail beforehand, at support@imaginary.tech. We
could use any of the following hardware:
•

Remote Controls (USB, infrared, RF, Bluetooth 2.1 or Bluetooth 4.0 LE)

•

Working Chromebook laptop (we’ll start supporting this platform immediately if someone
donates one)

•

Working Apple computer that runs, at least, OS X 10.9

•

Working, small, computer running the latest FreeBSD with Gnome 3 or MATE

Become a Translator
We’re hoping that starting version 2.4.0 onward, Teleprompter can allow translations from the open
source community into other languages other than English. Let us know if you’re interested in
contributing a translation at support@imaginary.tech, no compromises, it’s just so we can let you
know when our site is ready for such contribution.

Add a Feature or Support a Platform
HTML, CSS, Javascript, interest in the software, and a technical mind is all it takes to be a part of the
team. Before publishing a fork, a feature or submitting a patch, you should get in touch with us to
make sure what you intend to make will stay in a future release.
Write to us at support@imaginary.tech, regarding your interest to develop a feature, or support a
platform, such as ARM architecture Linux distributions, or mobile operating systems.
If you intend to develop a feature and would like it to be included in a future release, please read
How to Join our Development Team.
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How to Join our Development Team
1. Learn to use the software and think of ways how it could be programmed.
2. Successfully build distribution packages for your operating system following our building
process at:
https://github.com/ImaginarySense/Teleprompter-Electron#installer-building-instructions
3. Read the source code to have a basic understanding of how the software was written and
how it works. The most important files are index.html, teleprompter.html, js/editor.js, and
js/teleprompter.js from Teleprompter-Core; and main.js with package.json from TeleprompterElectron. CSS forms a huge part of the logistics behind Teleprompter’s functionality, so you
may also check css/editor.css, and css/teleprompter.css from Teleprompter-Core.
4. Write to us at support@imaginary.tech, regarding your interest to develop a feature and how
you might do it. We’ll take your ideas into consideration and reply to you with what we think
could be the best way to develop such a feature and more interaction will follow from there.

How We Manage Copyright Under the GPL
Each contributor retains copyright over their own work and voluntarily shares that copyright with
Imaginary Sense when they make code contributions. Only Imaginary Sense and the original
authors, Javier Oscar Cordero Pérez and Victor Alfonso Ortiz Alvarado, retain full copyright over the
software.
Imaginary Sense, the original authors and all contributors to the software agree to give up certain
rights as copyright holders under the General Public License version 3.0.
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Developer Guidelines
Building Process
For Every Platform You Must First...
1. Install Git and NodeJS on your system.
2. Open a Terminal or Command Prompt at your desired build location.
3. Clone the Teleprompter-Electron repository and its submodules with the following command.
git clone --recursive https://github.com/ImaginarySense/Teleprompter-Electron.git

If by any chance you can’t use Git, you may instead of steps 2 and 3 do the following:
2. Download Teleprompter-Electron's source from
https://github.com/ImaginarySense/Teleprompter-Electron/archive/master.zip and
extract to a desired location.
3. Download Teleprompter-Core's source from
https://github.com/ImaginarySense/Teleprompter-Core/archive/master.zip and
extract into the /app folder of the previously extracted file.
4. Move to the root folder of the Teleprompter-Electron project.
cd Teleprompter-Electron

5. Download dependencies and submodules.
npm run setup

6. Follow platform specific building steps. If builds are successful, you should find your binaries
inside the dist folder.

For Linux
1. If you’re building for Linux, depending what packages you intend to build you should install
their dependencies as shown at: https://www.electron.build/multi-platform-build#linux.
Commands and dependency names may vary across distributions. The following instructions
assume you're using a Debian/Ubuntu derivative.
sudo
sudo
sudo
sudo

apt-get
apt-get
apt-get
apt-get

install
install
install
install

--no-install-recommends
--no-install-recommends
--no-install-recommends
--no-install-recommends

-y
-y
-y
-y

icnsutils graphicsmagick
rpm
#To build rpm
bsdtar #To build pacman
snapcraft #To build snap

2. Open Teleprompter-Electron's “package.json” in the text editor of your preference.
3. Locate the following lines:
"linux": {
"target":
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4. Under “target”, remove any targets that you don't intend to build for. (For example, you
would leave deb for Ubuntu, rpm for Fedora, and pacman for Arch or Manjaro.) Use `tar.gz`
for any other distros and `AppImage` if you wish to create a universal, portable, Linux app.
5. Save your changes.
6. Run the command that corresponds to your operating system's architecture:
◦ To build 32 bit packages, run:
npm run dist:linux32

◦ To build 64 bit packages, run:
npm run dist:linux64

◦ To build both 32 and 64 bit packages, run:
npm run dist:linux

◦ To build ARM7l packages, run:
npm install -g electron-builder
npm run dist:linuxarm

For Mac OS
Execute “npm run dist:osx”.
Building process only works on computers running Mac OS.

For Windows
•

Execute “npm run dist:win64” to create a 64 bit installer.

•

Execute “npm run dist:win32” to create a 32 bit installer.

•

Execute “npm run dist:win” to create both 32 bit and 64 bit installers.
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Development Cycle
Imaginary Teleprompter follows an Agile Project Management methodology. Most of the planning
and management occurs across informal communications in the form of e-mails, personal meetings
and a Facebook Messenger chat group.
Since the team also works on other projects from Imaginary Sense and outside of Imaginary Sense,
the rigorousness of our development cycle varies from time to time. Nevertheless, no matter how
much progress we’ve made during a sprint, new releases will be made on schedule and a one
month testing phase will precede every release.

Release Dates
From version 2.3.0 forward, new versions of Imaginary Teleprompter are released every August 1st
and every January 31st. Bug and security fixes are released sporadically all year long.

Sprints
Planning Phase
Up to a week for small features; as long as it takes for more complex features.
1. We pick a number of features, around 10 through 12 additions and improvements, from a list
of all the improvements that could be done. Priority is given to features and bug fixes
requested by the users and those that impact usability.
2. Smaller features are ordered by priority and split evenly across developers.
3. The more complex features, those that require research and experimentation, are usually
worked across more than one sprint. and are split across developers regarding their
understanding of existing code and their experiences with similar code. Developers
shouldn’t focus on more than two complex features at a time.
4. During this phase various prototypes of the more complex features are developed to
determine which implementations work the best.

Development Phase
2 to 3 months prior the testing phase. May vary under special circumstances.
5. Developers work in parallel. Some prefer to develop locally, others in separate branches. All
developers announce which files they’re modifying in order to prevent conflicts when
committing changes. Sometimes developers agree to wait for one another to finish before
committing changes.
Despite most development being done in parallel, we do pair programming to help
developers who’re having difficulties with their code or understanding the requirements. Pair
programming’s been done both in person and through remote screen sharing sessions.
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6. Developers test their own features and make sure they don’t interfere with other features
nor crash the program.
7. After testing is done, code that wasn’t commented during the development of the features
gets commented. Sometimes we developers are in a hurry and forget to follow this practice.
Feel free to file a support ticket if you feel some specific code needs additional commenting
to be understood.
8. Code gets uploaded to the GitHub development branches.
9. Other developers test the new feature, look at the code and give feedback to its developer.
10. Improvements are made to the code, usually by the author, sometimes by those who’ve
given feedback, and these improvements get uploaded to the GitHub developer branches.

Testing Phase
1 to 2 months prior release
11. We agree to develop no new features during this phase.
12. Focus goes into improving existing code for efficiency and usability.
13. We test for extreme use cases.
14. Features that don’t perform as desired are subjected to be disabled or removed for before
release.
15. Additional comments are made to the code where required.
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Coding Practices
1. Whenever possible a feature must be able to run from all supported web browsers and not
depend of Electron in any way. A feature may be created exclusively for Electron only if
there’s no way to achieve it in all supported web browsers without violating browser security
restrictions.
2. We write in pure JavaScript and avoid JQuery to maximize performance.
3. JQuery is used only to control JQuery libraries such as the Timer and JQuery/PEP.
4. Keep JavaScript, CSS and HTML decoupled.
5. Avoid using “!important” on CSS instructions.
6. Default values for DOM elements should be assignable from the HTML source, not the
JavaScript.
7. Code is abstracted to enable re-usability and maintainability.
8. Teleprompter operations and the Editor follow a procedural programming paradigm.
9. Reusable elements have their own libraries and they’re coded with an object oriented
paradigm.

Syntax
1. camelCastVariableNames
2. Brackets go next to function declarations, like this:
function methodName(requiredArgument1, .., optionalArgumentsObject) {
// Contents
}

3. Comments are always welcome. Comments should describe purpose of code, not describe
exactly what the code is doing unless this is not clear from simply reading the code itself.
4. Variable names and code should be descriptive in such way that comments aren’t obligated
for an English speaker to understand the code.
5. Every method must have a comment describing its purpose before declaration.
6. If a developer didn’t comment his code and you’re having trouble understanding it, please
let us know.
7. Comments should always be used to describe arithmetic, mathematical functions and interprocess communication.
8. Comments and reference documentation should always be in English to enable more
developers from outside of the team. Exceptions may be made with Spanish and other
languages that the team speaks, but these should be translated to English, by a speaker of
both languages, before release.
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User Manual
Installation
Windows
Versions 2.3.x and Prior
1. Download the latest Windows binary from SourceForge:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/latest/download
Get the current 32 bit installer from:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/v2.3.1/Teleprompter32bit-2.3.1.exe/download
2. Double click on the installer. The following Image will appear on the screen:

3. Once it’s gone, Teleprompter has been successfully installed.
You will get the an error if you attempt to run the 64 bit version on a Windows 32 bit machine, and
the following error if you run attempt to run Teleprompter on a machine Windows XP or earlier:
“Not a valid Win32 program.”
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Mac OS
Download the latest Mac OS binary from SourceForge:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/latest/download
Open the .dmg file. The following window will appear:

Drag Teleprompter into the Applications folder to install it. Once it’s been successfully copied, close
the .dmg file.
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Linux
AppImage is a standalone version of Teleprompter that works on all mayor Linux distributions. It’s
best to use your distribution’s preferred installation method, if possible, instead of the AppImage;
because those allow to fully remove the software afterwards. Also “imaginary-teleprompter” is not
added to your terminal environment’s program list when using the AppImage.
You will get the following error if you attempt to install the 64 bit version on a Linux 32 bit machine:

cannot execute binary file: Exec format error
Get the latest 32 bit installers from:
https://github.com/ImaginarySense/Teleprompter-Electron/releases

AppImage
AppImage is a standalone version of Teleprompter that works on all mayor Linux
distributions. It’s best to use your distribution’s preferred installation method if possible
instead of the AppImage, because those allow to fully remove the software afterwards.
Your distribution may create shortcuts in your desktop environments to where the
AppImage resided at first execution. Those shortcuts are not automatically updated nor
removed upon moving or deleting the AppImage. Also “imaginary-teleprompter” is not
added to your terminal environment’s program list when using the AppImage.
1. Download the latest Linux AppImage from SourceForge:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/latest/download
2. Open the AppImage file.
3. Your distribution may prompt you to integrate it to the system for next execution. Imaginary
Teleprompter will load immediately after you answer to this prompt.

System integration prompt in Manjaro Linux with WindowMaker.
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Ubuntu / Debian
Download the current Debian package from SourceForge:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/v2.3.1/imagianryteleprompter-2.3.1.deb/download

Fedora
Download the current RPM package from SourceForge:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/v2.3.1/imagianryteleprompter-2.3.1.rpm/download

Arch
Download the current .pacman package from:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/v2.3.1/imagianryteleprompter-2.3.1.pacman/download

Manjaro (KDE, Octopi)
1. Download the latest .pacman package from:
https://sourceforge.net/projects/teleprompter-imaginary-films/files/v2.3.1/imagianryteleprompter-2.3.1.pacman/download
2. Rename the downloaded file from ‘imaginary-teleprompter-x.y.z.pacman’ to ‘imaginaryteleprompter-x.y.z.pkg.tar’
3. Start Octopi.
4. Click “File” > ”Install local package…”
5. Select the downloaded file.
6. Confirm installation.
7. Enter your password when requested.
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Editor Window
Imaginary Teleprompter’s primary window. This is where the user prepares the contents to be
prompted. It’s composed of an options header, a rich text editor, and a footer with information
about the software.
The rich text editor is composed of a toolbar, a “what you see is what you get” editing view, and
the editor’s status bar.

Options Header Bar

•

Save icon: Opens the File pane, where the user can create, rename, import and export files.

•

Teleprompter logo: Links to Imaginary Teleprompter’s website.

•

Settings icon: Opens and closes the Setup Panel.

•

Prompt It option: Starts prompting. Same as pressing the F8 key.

Setup Panel
Allows setting up teleprompter instances. Click on the cog-wheel

to open and close the Setup

Panel. All settings in the panel are saved automatically on program close, except for the current
custom style.
See Set Default Style for more details about this...
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Screen & Mirror Controls
You can have up to two independent prompt outputs with Imaginary Teleprompter. These are meant
to provide users with mirroring options across various hardware solutions. One output can be used
for prompting a flipped image that’s copied across multiple screens, while the other could prompt
an image without flip, or a different flip, for monitoring purposes. Any or both outputs can
accomplish one purpose or the other. Both outputs are rendered independently to provide the
highest quality.

Mirroring Modes

Mirroring modes are the same in the In-frame prompter as in the External prompter.
1. Disabled: Said prompter won’t be instantiated.
At least one prompter must be enabled when you choose to start prompting.

You must prompt at least to one display.
If you have only one screen and both instances are enabled, you will be forced to disable
one. This last premise applies only to the Electron version of the software.

22

Electron only warning: You don't have a
second display.
2. No Flip: Prompt is shown as is.

No flip.
3. Horizontal Flip: Prompt is flipped horizontally. Use this with a teleprompter mirror and a
regular screen with its bottom looking towards the camera.

Horizontal flip.
4. Vertical Flip: Prompt is flipped vertically. Use this with a teleprompter mirror and a regular
screen with its bottom looking away from the camera.

Vertical flip.
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5. Double Flip: Prompt is flipped horizontally and vertically, which is the equivalent of rotating
it 180°. Use this for on a prompter with no mirroring, where the screen is rotated on its head.

•

This bar also causes the vertical center to be offset slightly towards the button. For this
reason, we advice using the “In-frame” for monitoring and the “External” for your talents.

•

The “In-frame” prompter loads faster than the “External” because there’s no need to load a
separate window.

•

Flipping instances causes no perceivable performance impact in either prompters.

External Prompter

•

The External prompt loads your prompt on a new window.

•

When one screen is present, the External prompt loads its window on top of the Editor
window.

•

When two screens are present, the External instance loads its window on the screen
adjacent to the Editor window (or In-frame instance). This doesn’t always occur in the online
version of this software, and is something we cannot control because of browsers’ security
measurements. Use the standalone version to get all of Imaginary Teleprompter’s features.

•

When more than two screens are present, the External instance loads its window on the first
of the first two screens where the Editor window (or In-frame instance) isn’t located.

•

You can tell the “External” instance from the “In-frame” because the In-frame shows the
Options Header Bar and the “External” does not. The user must press the “Escape” key from
the “External” instance in order to return Teleprompter to its prior state.

•

We recommend using the In-frame for monitoring and the External for your talents. This is
because the In-frame’s vertical center gets slightly displaced towards the bottom, while the
External’s remains at the screen’s true center.

•

The “External” prompter loads slower than the “In-frame” because it needs to open a
separate window.

•

Flipping instances causes no perceivable performance impact in either prompters.

•

If you have only one screen present and you try to use both the In-frame and the External
prompter, you will get the following error in the standalone version of this software:
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You don't have an external Display.
Live Update Mode
You can add new contents to the prompter, live, by following these steps:
1. Disabling the In-frame. This will leave the editor open when you begin prompting.

Select disabled on the "In-frame
prompter".
2. Enable the External prompter. Select any one of the external options but “Disabled”.

3. When you start prompting, the Editor will remain on the current screen, and the prompt will
occur at the first screen Imaginary Teleprompter isn’t occupying. The Options Header Bar will
update to contain “Update” and “Close It...” options.
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4. Click on the Editor, or press Tab enough times, to focus it and make your changes.
Click outside of the editor or into the prompter’s screen to control the prompter with the
keyboard.
It is advisable to use the WASD keys to control the prompter while in Live Update Mode, to
prevent the Editor window from scrolling.
5. After you’ve made your changes, click on “Update” for your changes to take place in
Teleprompter.

New contents being typed into the editor while the external prompter is on and scrolling at a constant
speed.

Prompter Style

Imaginary Teleprompter comes with a variety of color combinations for reading. Styles, or color
combinations, consist of a font color, a background color, and the color of a transparent overlay
that covers the areas the talent should not read from.

Color Combinations for Version 2.3.1
•

Azure Light: background: #000000; overlay: #202020; text: #229FFF
Light azure (blue) text, over black background and dark gray overlay
Inspired on Star Wars: A New Hope original opening’s color scheme.

•

Blackboard: background: #000000; overlay: #202020; text: #229FFF
White text, over soft gray background and black overlay.
Inspired on the Monokai color scheme.
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•

Classic Yellow: background: #000000; overlay: #000000; text: #FFFF00
Yellow text, over a black background and black overlay
Inspired on popular Credit scrolls from the 1970s.

•

Dark Matter: background: #222222; overlay: #000000; text: #FFFFFF
White text, over dark gray background and black overlay
A reference to the astronomical term.

•

Whiteboard: background: #FFFFFF; overlay: #CCCCCC; text: #272822
Dark gray text, over white background and light gray overlay
A play on the Blackboard color scheme.

Custom Style
You can create new custom color schemes by selecting “Custom Style” from the Prompter style
options. Selecting “Custom Styles” will load the Custom Styles Administration Pane.
See Custom Styles Administration Pane for more details.

Focus Area
Focus Area or Focus Modes refers to the part of the screen that marks the area the talents should
read from.

There are 5 focus modes in Teleprompter (older versions may have less):
1. None: Shows no overlay. The top of the screen is considered to be the point
where the talent reads from.
2. Top Focus: Shows transparent overlay. The top of the screen is considered to
be the point where the talent reads from.
3. Middle Focus: Shows transparent overlay. The middle of the screen is
considered to be the point where the talent reads from.
4. Bottom Focus: Shows transparent overlay. The bottom of the screen is
considered to be the point where the talent reads from.
5. Interactive mode: Same look as “None”. Differs in that mouse controls are
removed to enable the user to interact with the hypertext being scrolled.
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Speed and Acceleration
Every time the user presses Up or Down on the keyboard when prompting, velocity is decreased or
increased one step, correspondingly. Scrolling the mouse wheel forward or backwards also increases
or decreases one or more steps in velocity.
Actual velocity is relative to each teleprompter instance’s resolutions. These are abstracted and
managed internally to allow a consistent use experience across all kinds of screens and devices.

Speed

Controls steps’ speed increments.

Acceleration

Controls steps’ acceleration increments.

Speed and Acceleration Tips
•

As the scale of the font increases, speed and acceleration steps should be increased as well.

•

Lower speed increments combine well with higher acceleration increments.

•

The lower the speed increments, the more steps it takes for the prompter to reach a desired
speed.

•

The higher the acceleration curve, the quicker the prompter will increase and decrease
velocity after a few steps.

Font Scale

Scales all text with relative units of measurement. By default, all text in Imaginary Teleprompter’s
Editor uses relative units measurement.
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Font scale at default 120%.

Font scale increased to 200%.

Timer

Enable or disable a timer for both in-frame and external prompters. The blue background indicates
whether the timer is On or Off.

Timer, counting, at the bottom of the screen.
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Editor
Imaginary Teleprompter is one of the few teleprompter software to come with a Rich Text Editor.
Most teleprompter software allows editing plain text only and have no image support. We achieve
this through the power of HTML, CSS, JavaScript, CKEditor and applied calculus.
CKEditor is a free software Rich Text Editor that we have incorporated into Teleprompter. We chose
CKEditor over other editors because it is very feature rich, extensible and robust. It works very
much the same way as any other word processor, such as Libre Office Writer and Google Docs.

Editor Toolbar
Use this Toolbar to make changes to the contents you’ll prompt. It’s useful to study and experiment
with it’s features, for here’s where content creators can get the most creative.

File Options

Clear File
You can clear the contents of the current document by pressing this button. This does not
create a new document. This button shall be removed in future releases because it causes
confusion.
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Source Editor
Opens an HTML source code editor for the user to make changes to the contents in the
regular editor. Advanced users could use the “Source Editor” along with “Interactive Mode” to use
Teleprompter as a programmable interactive display.

Source code editor.
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Edit Options

Cut, Copy and Paste

Cutting and Copying
•

Cut (CTRL-X): Removes selected contents and adds them to the clipboard.

•

Copy (CTRL-C): Does not remove selected contents but does adds them to the clipboard.

Pasting
These icons are present to be used in the online version of Teleprompter. The standalone version is
based on the online version, so they’re still present but don’t really apply.
•

Paste (CTRL-V): Inserts the most recent contents of the clipboard into the location
indicated by the keyboard’s cursor.

•

Paste without format: Removes all format from text before pasting.

•

Paste from MS Word: Allows pasting text with MS Word formatting in older browsers.
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Find and Replace

Find
Loads the Find and Replace dialog on its “Find” tab.
1. Type the text you intend to look for in the text-box to the left of the “Find” button.
2. Enable and disable options by checking and unchecking the check-boxes under Find Options.
3. Press the “Find” button to look for the next instance of your text in the document.
4. Once you’re done, click on “Close” or the “X” at the top right.

Find dialog.
Replace
Loads the Find and Replace dialog on the “Replace” tab.
1. Type the text you intend to replace into the text-box to the left of the “Replace” button.
2. Type the text you intend to replace with into the text-box to the left of the “Replace All”
button.
3. Enable and disable options by checking and unchecking the check-boxes under Find Options.
4. Press the “Replace” button to replace the next instance of text matching in the document.
5. Or press the “Replace All” button to replace all instances of text matching in the document.
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6. Once you’re done, click on “Close” or the “X”at the top right.

Find and replace dialog.
Find Options
1. Match case: Returns matches only when the capital letters and non capital letters match
as.
2. Match whole word: Matches only to text that’s being preceded and followed by white
space.
3. Match cyclic: Searches begin at the location of the keyboard cursor. Enabling this makes
the the algorithm search the rest of the document from the beginning, after the bottom has
been reached.
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Select All
Selects all of the contents in your editor. You may also press CTRL-A while the editor is
focused.

Spell Check
Opens the Spell Check options. This spell check works only with the online version and
requires internet access to function. Future versions of Teleprompter will implement a different spell
check for offline use with the standalone version.
“Enable SCAYT” to have real time spell checking. This must be done once per session. SCAYT
checks newly typed text, not that which was previously typed.

Default values.

SCAYT Enabled.

Click on “Check Spelling” to open the Spell Checker dialog.

Spell Checker Dialog
See http://scayt.com/user_manual/scayt_plugin_for_ckeditor4_user_manual.pdf for full
documentation on how to use the spell check.
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Insert Options

Insert Image
Allows inserting images into Teleprompter.
•

URL: Type the address to the image’s location. The location can be somewhere in the
internet or locally, in your computer. Please note that if a Imaginary Teleprompter file is
exported, the linked images are not exported with it. We shall fix this in future releases.

•

Alternative Text: Placeholder text to show if the image isn’t found or currently unavailable.

•

Width: The image’s width measurement in pixels. This value is ignored and a default size of
100% available space is used instead.

•

Height: The image’s height measurement in pixels. This value is ignored and an automatic
value that does not change the aspect ratio is used instead.

•

Alignment: Because width is automatically set to 100%, any alignment value should result in
identical outputs.

Insert Flash Content
The ability to play flash contents is present but there’s no official support for it. It works similar
to Insert Image. Please see Ck Editor's documentation for more details on how to use it.
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Insert Table
Pops a grid where the user may click any cell to create a table of the size indicated by the
number of gray colored cells.

User creating a 1 by 3
cells table.
A user may press “More...” to setup a table from the Table Properties window.

Table Properties window.

Advanced Table Properties.
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Table Context Menu

1

2

3

4

Column options
Right clicking on a
table loads this
context menu.

Row options

Actions that can be
applied to the currently
selected Cells

Cell Properties

Cell options: lookup HTML tables for more information.

Insert Horizontal Line
Inserts a horizontal line that takes up the entire width of the usable editor area.
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Insert Symbol
Opens a dialog to insert any symbol printable by the user’s computer.
1. Select the alphabet system to look for your symbol from the drop-down menu to the top left.

2. Then click on the symbol you wish to insert to insert it.
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Insert Formula
Opens the CodeCogs Equation Editor, which allows users to create mathematical equations and
insert them into the editor. The user may press the symbols and lists to the upper area of the
equation editor to insert symbols that will form the equation. They may also type it manually into
the yellow text box, using LaTeX syntax. Learn more about LaTeX at https://www.latex-project.org/.
Above the Editor and bellow the symbols are settings regarding text size. The initial settings are
CodeCogs’ defaults. Increase font size to get an image with good enough quality for prompting.
Using CodeCogs requires an active internet connection.

CodeCogs Equation Editor.
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Font Options

Caps Control

•

Exchanges capital letters for minuscule letters and vice versa.

•

Makes all letters minuscule letters.

•

Makes all letters capital letters.

•

Makes the first letter of each word capital, and the letters that follow, minuscule.

Font Color & Highlight

•

Drops down a color picker to choose font-color.

•

Drops down a color picker to choose highlight color.

When you press “More Colors” on either color picker, the following color picking dialog shows up:
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Color picking dialog
To choose a color that’s not in the screen, type a hexadecimal color on the input field bellow the
“Selected Color” preview and press enter for the preview to update.

About CKEditor
Shows information about the version of CKEditor being used in Teleprompter.

“About CKEditor” screen in Imaginary Teleprompter versions
2.3.x
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Anchor Flag
Pops an input to create HTML anchors in the document.
Please see How to use anchor shortcuts for more information about how to make use of this when
prompting…

Font Options (continuation)

Font Style

•

Makes selected text, or text typed from the keyboard’s cursor position, appear in Bold.

•

Makes selected text, or text typed from the keyboard’s cursor position, appear in Italics.

•

Makes selected text, or text typed from the keyboard’s cursor position, appear
Underlined.

•

Makes selected text, or text typed from the keyboard’s cursor position, appear Strikethrough.

Subscript & Superscript

•

Makes selected text, or text typed from the keyboard’s cursor position,

subscript

.

•

Makes selected text, or text typed from the keyboard’s cursor position,

superscript

.

Remove Formatting
Removes all formatting from selected text.

Bullets & Numbering

•

Starts an ordered list at the beginning of the line indicated by the keyboard’s cursor.

•

Starts a bullet list at the beginning of the line indicated by the keyboard’s cursor.

•

Removes indentation from the current paragraph.

•

Indents the current paragraph.

Right-click on a list to and select “Bulleted List Properties” or “Numbered List Properties” to control
other details, such as the starting number of the bullet art.
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Bulleted List Properties, listing possible bullet
decorators.

Numbered List Properties, starting number set to
one, and listing possible numbering systems.

Text Orientation

•

Orients the current paragraph towards the left.
•

Orients the current paragraph towards the center.
Orients the current paragraph towards the right.

•
•

Uses justified orientation for the current paragraph. We recommend not to use this
feature frequently, as it makes text harder to read.

LTR & RTL Paragraphs

•

Formats the current paragraph for left to right typed languages.
•

Paragraph Styles
Assigns pre-made styles to the line indicated by the keyboard’s cursor.
Available styles include: headings, code containing boxes and DIV containers.

45

Font Family
Assigns a font to the currently selected text, or text typed from the keyboard’s cursor
position.
Available fonts included in Teleprompter 2.3.x include:
•

Arial

•

Lucida Sans Unicode

•

Comic Sans

•

Tahoma

•

Courier New

•

Times New Roman

•

Georgia

•

Trebuchet MS

•

Verdana

Font Size
Assigns the font-size for the currently selected text, or text typed from the keyboard’s
cursor position.
Possible font size values go from 0.7 to 3.0 times the base size.
Font sizes in Imaginary Teleprompter use the em measurement unit, which is a unit of measurement
relative to a pre-indicated font-size. This allows scaling the entire text of a document dynamically
using the Font Scale setting, it also allows properly synchronizing instances across screens with
different scales and resolutions.

Line Height
Assigns the line height for the currently selected text, or text typed from the
keyboard’s cursor position.
Possible line height values go from 1.0 to 2.0 times the base size.
Line heights in Imaginary Teleprompter use the em measurement unit, which is a unit of
measurement relative to a pre-indicated font-size. This allows scaling the entire text of a document
dynamically using the Font Scale setting, it also allows properly synchronizing instances across
screens with different scales and resolutions.

Word & Paragraph Counter
Counts the number of words and paragraphs in the document.
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WYSIWYG Editing View
Allows the user to edit and see the contents as they would be prompted on screen. Clicking on the
editor’s contents places the keyboard’s cursor there, allowing the user to insert new contents.
Only when the currently loaded document is the “Instructions” document, the user won’t be
allowed to edit and instead be prompted to create a new document. See Creating a New File for
more information.

Editor's view with Instructions document loaded.
Context Menus
Right clicking on any part of the editing view loads a context menu. Context menus are called this
way because their contents vary depending on the element the mouse or keyboard cursors are
pointing to. Some of CKEditor’s features are only accessible through context menus.

Example context menu. The user is selecting part of an anchored text, that is part of an ordered list.
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Editor Status Bar

CKEditor comes with a status bar, to the bottom-left of the editor, that indicates the DOM hierarchy
of the element positioned behind the keyboard’s cursor. This feature is very useful for those
knowledgeable in HTML and helps create more complex layouts, as shown in the following image:

Here the user is selecting the “tbody” element of an HTML table, showing that the table contains
tree cells: one to the left of the image, one containing the image, and another to the right of the
image. Placing the image on the second cell of this table is a workaround to present it at a scale
lower than 100% of the editable area’s width. Instead, the image takes 100% of the cell that
contains it, which takes one third of the editable area.
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Custom Styles Administration Pane
You can create custom color schemes by selecting “Custom Style” from the Prompter Style options.
The following screen appears when you select “Custom Style”:

Create a New Style
1. Select a style that you want to reference from on the “Styles” selection column, at left.
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2. Click on each of the color bars in the properties section to open the color picker and choose
your colors.

3. On the bottom of the Custom Styles pane, click on the text box to the right of “Style Name”
and type a name for your style.

4. Once you’ve named the style, click on the “New Style” button to the right of “Style Name”,
to create it.

50

Update a Style
Say you missed step 2 while creating a new style, or you or your talent don’t like how it looks in
practice all you have to do is update its color pallet. Please note that only custom styles can be
updated and presets cannot.
1. In the Custom Styles Administration Pane, select the style you want to update from on the
“Styles” selection column, at left.

2. Click on each of the color bars in the properties section to open the color picker and choose
your colors.
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3. Once you’ve changed your pallet, click on the “Update Style” button to the right of “Style
Name”, to save your changes.

Set Default Style
The “Default Style” is the style that gets loaded when the program gets started. You may change
the default style to any style, preset or custom, following these steps:
1. In the Custom Styles Administration Pane, select the style you want to update from on the
“Styles” selection column, at left.

2. Click on the “Set As Default” button to the bottom right of the Custom Styles Administration
Pane.

Reorder Styles
*Warning: Version 2.3.1 contains a bug that prevents changes in order from manifesting when
prompting. We apologize for the inconvenience. Please refrain from using this feature.
1. In the Custom Styles Administration Pane, select the style you want to move from on the
“Styles” selection column, at left.
2. After selecting a style, two arrows will appear in the selection area.
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3. Press the Up arrow to move this style before the previous style or press the Down arrow to
move this style after the following style.

Custom styles sorted around.
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File Options
Create a New File
Imaginary Teleprompter loads the instructions file by default, in order to allow new users to learn to
use the program quickly.
1. You can begin to create a new file in the following ways:
•

If the instructions are open, you can begin typing on the editor, Teleprompter will prevent
any attempts to modify the instructions and prompt you to type the title of a new file.

•

You may open the Files side pane by pressing the Floppy icon

at the top left of the

Editor Window. Then click on “Add Files”, you’ll be prompted to type the title of a new
file.
The Files pane will show to the left of the screen:

2. You’ll be prompted to write a title for the new document. Once done typing press Enter or
click on “Add Script”. If you don’t want to create a new document, press “Cancel” on the
screen or the “Esc” key on your keyboard.

54

Saving Files

Edit File Name
1. Open the Files side pane by pressing the Floppy icon.
2. Click the pencil icon next to the file you want to edit.

3. Type the changes to your title.

4. Press the “Enter” key when done to save the changes.

Moving Files Across Machines
On the Computer We’re Copying From...
1. Open the Files side pane by pressing the Floppy icon.
2. Click the download icon (arrow signaling bottom inside of a circle) next to the file you want
to move to another machine.

3. A save dialog will appear. The dialog will vary depending on your platform.
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On the Computer We’re Copying To…
1. Open the Files side pane by pressing the Floppy icon.
2. Click on the Import Script option.

3. A file dialog will load. The dialog will vary depending on your platform. Select all files you
intend to import and click “Open”. Unsupported files will not be opened. HTML files that do
not come from Imaginary Teleprompter may not load properly. See Supported File Formats
for more information…
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4. Imported files get their names from the name of the files’ name in the filesystem.
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Prompter Window
Input Controls
Velocity Controls
•
•

Increase velocity : Down, S
Decrease velocity : Up, W

Font Scale Controls
•
•

Increase font scale : Right, D
Decrease font scale : Left, A

Timer & Playback Controls
•

Reset : Backspace

•

Play/Pause : Space bar

Unique Inputs
•

Synchronize teleprompter instances : . (use with care)

•

Start prompting : F8

•

End prompting : ESC

•

Enter/leave full screen : F11
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How To Use Anchor Shortcuts
1. Select a keyword or line you want to jump to on your text in the editor.

2. Click on the “Anchor Flag Icon”, on the editor's toolbar.

3. A box named "Anchor Properties" should have appeared. Type any single key of your choice
and click 'OK'.

Note: preassigned keys, such as WASD and Space bar will be ignored.

A thin dashed blue line now surrounds the previously selected area, marking it as anchored.
4. Repeat steps 1 through 3 for as many shortcuts as you wish.
5. When prompting, press the shortcut keys to jump into the desired locations.
Note that the anchored contents will jump to the bottom part of Focus Area (upper part if
using vertical or double Mirroring Modes).
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Support and Services
Distribution Contract: Inclusion with Teleprompter
Hardware
While the GPL permits to sell copies of the software, to cover distribution costs and such, Imaginary
Sense does not charge for its binaries. As a matter of fact, Imaginary Teleprompter may be included
with teleprompter hardware manufactured and sold by third parties for free, as long as these
parties comply with all the requirements of the GPL 3.0. If a party was interested in distributing
Imaginary Teleprompter but cannot comply or does not wish to comply with the requirements of the
GPL 3.0, they need to contact Imaginary Sense, and only Imaginary Sense, to reach an agreement
for a distribution contract.
Reasons to enter in such an agreement could include:
1. To change Imaginary Teleprompter’s branding
2. To remove credits
3. To not include a copy of the source code along the binaries
4. To avoid having to comply with the anti DRM restrictions of the GPL 3.0
5. To not disclose necessary changes required to support your hardware

Support Service Contract
If you were interested in us adding a new feature or supporting a specific platform to satisfy your
particular needs, you may wish to contact us regarding a feature request and inquiry about a
support contract. We should reach an agreement that could range from Imaginary Sense sponsoring
your productions, to paying a fixed or periodical fee for the development of a feature.
Agreements vary depending on how much it costs us to develop such feature, how much value it
adds to other users, whether these modifications are for personal or commercial use, and whether
the modifications are to be shared under the GPL 3.0.
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Annex
Changes in this Cycle
This release is all about usability. We've added more features and bring you a cleaner interface. Our
branding changed from Imaginary Films to Imaginary Sense but we remain the same team, looking
forward to bring great quality multi-platform software.

2.3.3
1. Fixed ghost process on window closed bug.

2.3.2
2. Added full 32 bit support
3. Added experimental ARM7L support.
4. Patched Electron security issues.

2.3.1
5. Fixes a bug that prevented the prompt's scroll from sometimes reaching the end.

2.3.0
1. Increased Performance
2. New File Management Features
3. New Speed Precision Controls
4. New Timer
5. New Fast Text Resize
6. New Custom Styles
7. New Focus Modes
8. Improved Instance Synchronization
9. Improved Live Update Feature
10. Improved User Interface
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Plans for the Next Two Releases
1. Add support for Safari Mobile on iOS and Google Chrome Mobile on iOS and Android
2. Implement previous and next anchor navigation
3. Remove the editor window’s scroll bar
4. Improve editor usability on touch devices
5. Implement unnamed anchors
6. Move footer information and options into About section of window menu
7. Add Full Screen option into window menu.
8. Add multi-platform SVG Emoticon Support
9. Implement software translations
10. Finish implementing image uploads manager
11. Implement generic Bluetooth LE remote control support
12. Improve keyboard and assistance technologies usability through the use of menu
13. Implement Local Spell Check
14. Improve Custom Styles usability
15. RTF file format support

